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本ガイドでは、PA 800 Plus EmpowerTM Driverのインストールに関する情報と手順について
説明します。PA 800 Plus EmpowerTM Driverでは、PA 800 Plus Pharmaceutical Analysisシ
ステムからのデータ収集をWaters EmpowerTM 3 (FR4)ソフトウェアを使用することで可能
にします。PA 800 Plus EmpowerTM Driverは、Waters EmpowerTMソフトウェアと同じコン
ピュータにインストールする必要があります。
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オペレーティングシステム要件

このバージョンのソフトウェアは、MicrosoftWindows10（64ビット）と互換性があります。
コンピュータの要件については、セクションコンピュータの要件を参照してください。

コンピュータの要件

コンピュータは、MicrosoftWindows10（64-bit）ソフトウェアの最小要件を満たしている必
要があります。詳細については、Watersから提供されるドキュメントを参照してください。

空きUSBポートも必要です。

検証済みのコントローラー構成

表 2-1検証済みのコントローラー構成

詳細項目

Microsoft Windows 10 Enterprise 2016 LTSBオペレーティングシステム

• Oracleクライアントバージョン12.1.0.2.0（32ビット用）

• Waters EmpowerTMソフトウェア

• National Instrumentsドライバー、バージョン19

追加ソフトウェア

最小：Windows 7または 10の CPU、Intel 2 Duo、E6400
2.13 GHz

推奨：Intel Core 2 Duo、E8400 3.0 GHz

CPU

最小：4 GB

推奨：8 GB

ランダムアクセスメモリ

（RAM）

最小：25 GBハードドライブ

2 GB（Waters EmpowerTMソフトウェアの場合）空きディスク容量

最小：分解能1024×768（LAC/Eモジュールを除く）

推奨：分解能1920×1080（クライアントの場合）

モニター
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表 2-1検証済みのコントローラー構成 (続き)

詳細項目

8ポートシリアルハブオプションの制御インター

フェース

ネットワーク接続用Ethernetアダプター x 1
最小：100 Mbps以上

推奨： 1 Gbps

Ethernetアダプター

必要なソフトウェア

Waters EmpowerTM 3ソフトウェアがインストールされている必要があります。PA 800 Plus
EmpowerTM DriverはWaters EmpowerTM 3 (FR4)ソフトウェアによって検証済みです。

早期アクセス顧客評価中に、顧客は PA 800 Plus EmpowerTM Driverを評価し、それが
EmpowerTM 3 (FR2)ソフトウェア以降と完全に互換性があることを確認しました。

追加のデータ処理機能を使用する場合：

• SDS-MWおよび cIEFアプリケーションの定性分析計算を行うには、Waters EmpowerTM

GPCソフトウェアが必要です。

• 分解能やノイズとドリフトなどの標準的な薬局方の計算を行うには、Waters EmpowerTM

System Suitabilityソフトウェアが必要です。

どちらのソフトウェアのライセンスを購入する場合も、Watersの営業担当者にお問い合わせ
ください。

必要な PA 800 Plusファームウェアバージョン
PA 800 Plus EmpowerTM Driverは、以下のバージョンの PA 800 Plusファームウェアを搭載
したシステムで検証済みです。表 2-2を参照してください。

表 2-2検証済みの PA 800 Plusファームウェアバージョン

ファームウェアバージョンPA 800 Plusシステム

10.2.3非 ROHS認証の PA 800 Plusシステム

10.2.5-RROHS認証の PA 800 Plusシステム

10.3.7-RCESI 8000 Plusシステム

PA800Plusのファームウェアが検証済みのバージョンでない場合は、PA800PlusEmpowerTM

DriverとWaters EmpowerTMソフトウェアおよび動作確認に使用された SCIEXツールとの
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互換性を確実にするために、ファームウェアをアップグレードする必要があります。Waters
EmpowerTMソフトウェアを使用してファームウェアバージョンを決定するを参照してくだ
さい。

PA 800 Plusシステムのファームウェアバージョンを決定する
Waters EmpowerTMソフトウェアを使用してファームウェアバージョンを決定する

1. Waters EmpowerTMソフトウェアを開き、Run Samplesをクリックします。

2. 正しいシステムを選択し、OKをクリックします。

3. View > Systemをクリックします。

図 2-1システム情報ダイアログ

4. Scan Instrumentsをクリックします。

OK?カラムが Yesであれば、ドライバーは LAC/Eモジュールと通信しています。

5. 右にスクロールして Detailsカラムに移動します。

ファームウェアバージョンは、システムのその他の詳細情報とともに表示されます。
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図 2-2ファームウェアバージョン

ファームウェアの更新が必要な場合は、SCIEXの営業担当者にお問い合わせください。

32 Karatソフトウェアを使用してファームウェアバージョンを決定する

1. 32 Karatソフトウェアを開きます。

2. 正しい機器を選択してログオンします。

注： PA 800 Plusシステムとコントローラーが通信していることを確認します。

図 2-3 32 Karatソフトウェアウィンドウ

3. Control > Instrument Status > Viewをクリックします。

4. スクロールダウンしてファームウェアのバージョンを確認します。
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図 2-4ファームウェアバージョン

ファームウェアの更新が必要な場合は、SCIEXの営業担当者にお問い合わせください。
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以前にインストールされたドライバーの確認

1. Waters Empowerソフトウェア用BeckmanCoulter PACEMDQコントロールドライバー
がインストールされているかどうかを確認します。

a. コントロールパネル >プログラムと機能をクリックします。

b. Waters Empower SoftwareのBeckman Coulter PACE MDQコントロールを探し
ます。

存在する場合は、アンインストールします。Beckman Coulter PACEMDQControl
for Waters Empower Software Driverのアンインストールを参照してください。

2. 正しいバージョンのNational Instrumentsソフトウェアドライバーがインストールされ
ているかどうかを確認します。

注： PA 800 Plus EmpowerTM Driverには、National Instrumentsのソフトウェアドラ
イバーバージョン 19.0が必要です。別のバージョンがインストールされている場合
は、削除する必要があります。

a. コントロールパネル >プログラムと機能をクリックします。

b. National Instrumentsソフトウェアを探します。

バージョン番号が19.0ではない（またはバージョン番号が表示されていない）場合
は、アンインストールします。National Instrumentsソフトウェアドライバーの以
前のバージョンのアンインストールを参照してください。

Beckman Coulter PACE MDQ Control for Waters
Empower Software Driverのアンインストール
1. 開いているすべてのWaters EmpowerTMソフトウェアプログラムを閉じます。

2. Control Panel > Programs and Featuresをクリックします。

3. Beckman Coulter PACE MDQ Control for Waters Empower softwareをクリック
し、Uninstall/Changeをクリックします。

InstallShield Wizardウィンドウが開きます。

PA 800 Plus EmpowerTM Driverリリースノート
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4. Removeをクリックし、Nextをクリックします。

図 3-1 Beckman Coulter PACE MDQ Control for Waters Empower InstallShield
Wizard

5. 開いたメッセージで、Yesをクリックしてすべての機能を削除します。

6. アンインストールが完了したら、Finishをクリックして、InstallShield Wizardを閉じ
ます。

7. Program and Featuresコントロールパネルで、右クリックして Refreshを選択し、
Beckman Coulter PACE MDQ Control for Waters Empower softwareが消えている
ことを確認します。

それでもドライバーがコントロールパネルに表示される場合は、手順を繰り返してド

ライバーをアンインストールします。
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National Instrumentsソフトウェアドライバーの以
前のバージョンのアンインストール

注： PA 800 Plus EmpowerTM Driverには、National Instrumentsのソフトウェアドライバー
バージョン 19.0が必要です。別のバージョンがインストールされている場合は、削除する
必要があります。

1. コントロールパネル >プログラムと機能をクリックします。

2. National Instrumentsソフトウェアをクリックし、アンインストール/変更をクリック
します。

National Instrumentsソフトウェアウィンドウが開きます。

3. インストールされているドライバーのバージョンに応じて、次のいずれかを実行しま

す。

• Ctrl-Shiftキーを押しながら下矢印キーを押して、リスト内のすべての項目を選択
し、削除をクリックします。

図 3-2 National Instrumentsソフトウェアアンインストールダイアログ

PA 800 Plus EmpowerTM Driverリリースノート
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• すべて削除をクリックします。

図 3-3 National Instrumentsソフトウェアアンインストールダイアログ

4. アンインストールが完了したら、はいをクリックしてコンピューターを再起動します。

5. コンピューターが再起動したら、ログオンします。

PA 800 Plus EmpowerTM Driverのインストール

注： PA 800 Plus EmpowerTM Driverを Citrixサーバーにインストールしておく必要がある
のは、PA 800 Plus EmpowerTM Driverが Citrix環境の下で動作している場合です。

1. PA 800 Plus EmpowerTM Driver DVDを DVDドライブに挿入します。

2. PA 800 Plus Empower Driver V1.3.0フォルダーに移動してから、setup.exeをダブル
クリックします。

Open File - Security Warningダイアログが開きます。

3. Runをクリックします。

PA 800 Plus EmpowerTM Driver InstallShield Wizardが開きます。
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図 3-4 Sciex PA 800 Plus EmpowerTM Driver InstallShield Wizard

4. License Agreementページで I accept the terms of the license agreementをクリッ
クし、Nextをクリックします。

5. 画面に表示される指示に従ってソフトウェアをインストールします。入力を求められ

たら、デフォルト値を受け入れます。インストールの最初に警告が表示された場合は、

無視してください。

National Instruments Software Driverのインス
トール

PA 800 Plus EmpowerTM Driverには、National Instruments Software Driverバージョン 19.0
が必要です。

1. PA 800 Plus EmpowerTMDriverインストールDVDで、NI-488.2 19.0 Driverフォルダー
に移動し、Install.exeをダブルクリックします。

Open File - Security Warningダイアログが開きます。

2. Runをクリックします。

インストーラーはライセンス契約を確認し、次のページを開きます。
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図 3-5 NI Package Managerインストールウィザード

3. I accept the above 2 license agreements.をクリックし、NI Package Managerペー
ジが開くまで Nextをクリックします。

4. Additional items youmaywish to installリストでNI-488.2 .NET Language Runtime
17.0.1 for .NET Framework 4.5をクリックし、次に Nextをクリックします。

注意：通信エラーが発生する可能性があります。OKをクリックする前に、NI-488.2
.NET Language Runtime 17.0.1 for .NET Framework 4.5コンポーネントが選択さ
れていることを確認してください。コンポーネントがインストールされていない場

合は、LAC/EモジュールとPA 800 Plusシステムが通信できません。

注：デフォルトでは、このリストで他のコンポーネントが選択されています。それ

らも必要であり、選択したままにする必要があります。
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図 3-6必要な.NETコンポーネント

5. Agreeページで I accept the above 2 license agreements.をクリックし、Nextをク
リックします。

6. 次のページで I accept the above 2 license agreements.をクリックし、Nextをク
リックします。

インストールには数分かかる場合があります。

インストールが完了すると、NI更新サービスに関するメッセージが表示されます。

図 3-7 NI Update Serviceメッセージ

7. Noをクリックします。

8. インストーラーに NI Customer Experience Improvement Programに関するメッセー
ジが表示されたら、No, I do not want to participate in the NI Customer Experience
Improvement Programをクリックし、OKをクリックします。
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9. Reboot Nowをクリックしてコンピュータを再起動します。

10. コンピュータにログオンします。

注：ソフトウェアの登録を求めるダイアログが開いたら、Cancelをクリックして閉
じます。
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次の手順を使用して、PA800Plusシステムで動作するようにWatersEmpowerTMソフトウェ
アを構成します。

圧力単位の変更

Waters EmpowerTMソフトウェアは、psiまたはミリバールの単位で圧力を表示できます。デ
フォルトの場合、単位はミリバールです。圧力単位の変更は、LAC/Eワークステーションや
Citrixサーバーから行うことができます。

次の手順に従って、単位を変更します。

1. 管理者権限を持つユーザーとしてコンピューターにログオンします。

2. Waters EmpowerTMソフトウェアを閉じます。

3. Registry Editorウィンドウを開きます。

a. Startをクリックし、Rと入力して、Runをクリックします。

Runダイアログが開きます。

b. regeditと入力します。

c. 表示されるメッセージで Yesをクリックします。
Registry Editorウィンドウが開きます。

4. 圧力単位のレジストリエントリーを見つけます。

a. Edit > Findをクリックします。

b. （オプション）ツリー構造のHK_LOCAL_MACHINEフォルダーをクリックしま
す。

ヒント！HK_LOCAL_MACHINEを選択すると、エントリーの検索が非常に高速
になります。
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c. （オプション）Find what:フィールドに PressureUnitPSIと入力し、Find Next
をクリックします。

図 4-1 Findダイアログ

検索には、ある程度時間がかかります。キーが見つかると、Registry Editorウィン
ドウの右側のペインで強調表示されます。

図 4-2レジストリエディター

5. レジストリエントリーを編集します。
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a. PressureUnitPSIをダブルクリックします。

DWORD（32ビット）値の編集ダイアログが開きます。

図 4-3 Edit DWORD (32-bit) Valueダイアログ

b. Value dataフィールドに単位の値を入力し、OKをクリックします。

• psiの場合は1

• mbarの場合は0

c. File > Exitをクリックして変更を保存し、Registry Editorウィンドウを閉じます。

測定サーバーの構成

注：次の手順を完了する前に、Waters EmpowerTM 3 (FR4)ソフトウェアで測定サーバーを
設定します。手順については、ソフトウェアに付属の製造元のドキュメントを参照してく

ださい。

1. デスクトップの Empowerアイコンをダブルクリックし、管理者権限を持つユーザー
としてログオンします。

2. Waters EmpowerTM software Startダイアログで、Configure the Systemをクリック
します。
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図 4-4 Waters EmpowerTM Softwareの起動ダイアログ

Configuration Managerウィンドウが開きます。

注： 次の図のノードのリストは、ローカルのWaters EmpowerTMソフトウェアの構
成を反映しています。
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図 4-5 Configuration Managerウィンドウ

3. 表で、構成するノードを右クリックし、Propertiesを選択します。
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図 4-6 Node Propertiesダイアログの Generalタブ

4. Configure DHCPタブをクリックし、Configure DHCPをクリックします。
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図 4-7 Configure DHCPタブ

Waters DHCP Server Configurationダイアログが開きます。
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図 4-8 Waters DHCP Server Configurationダイアログ

5. Waters Empower SoftwareのBeckman Coulter PACE MDQコントロールドライバーが
以前にインストールされている場合は、リストから既存のCE装置を削除します。ダイ
アログで BCPACEMDQをクリックし、Removeをクリックします。

6. Addをクリックします。

Add IP Addressダイアログが開きます。

7. ダイアログのフィールドを次のように更新します。

図 4-9 Add IP Addressダイアログ
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a. IP Addressフィールドは空のままにしておきます。PA 800 Plusシステムには不
要です。

b. MACAddressフィールドは空のままにしておきます。このアドレスは不要で、自
動的に 00-00-00-00-00-00になります。

c. Instrument Typeをクリックし、リストから PA800PLUSを選択します。

d. Serial Number/Unique Nameフィールドに 1と入力します。

e. OKをクリックします。
MACアドレスに関するメッセージが表示された場合は、メッセージを閉じ、MAC
Addressフィールドに任意の番号を入力して、OKをクリックします。

8. Beckman Coulter PACE MDQ Control for Waters Empower Software Driverが以前に
インストールされていた場合は、Instrumentsタブをクリックします。

図 4-10 Instrumentsタブ

9. Waters Empower SoftwareのBeckman Coulter PACE MDQコントロールドライバーに
関連付けられている、以前に構成された装置を削除します。
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a. 削除する装置の行をクリックしてから、Remove Instrumentをクリックします。

以前に構成した装置の Type列に BCPACEMDQが存在します。

図 4-11確認メッセージ

b. 表示されるメッセージで Yesをクリックし、続いて表示されるメッセージで Yes
をクリックします。

c. Type列に BCPACEMDQが含まれる追加の装置がある場合は、手順を繰り返して
削除します。

10. OKをクリックします。

ノードのプロパティダイアログが閉じます。

11. 2番目の PA 800 PlusシステムをLAC/Eモジュールに接続する場合は、ステップ 7を
除いてこの手順を繰り返し、Serial Number/Unique Nameフィールドに 2を入力し
ます。

注： 2番目の PA 800 Plusシステムのセットアップに必要な追加の手順は、SCIEX
フィールドサービスの従業員が実行する必要があります。SCIEXテクニカルサポー
ト（sciex.com/request-support）までお問い合わせください。
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新規クロマトグラフィーシステムのセットアップ

WatersEmpowerTMソフトウェアは、クロマトグラフィー用に設計されています。このため、
ソフトウェアに接続されたすべての装置は「クロマトグラフィーシステム」と呼ばれます。

PA 800 Plusシステムは、使用する前にクロマトグラフィーシステムとして構成する必要が
あります。

1. Configuration Managerウィンドウで File > New > Chromatographic Systemをク
リックします。

New Chromatographic System Wizardが開きます。

図 4-12 Type Entryページ

2. Create New Systemをクリックし、Nextをクリックします。

注： 次の図のノードのリストは、ローカルのWaters EmpowerTMソフトウェアの構
成を反映しています。
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図 4-13 Select Serverページ

3. PA 800 Plusシステムのノードをクリックし、Nextをクリックします。
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図 4-14 System Selectionページ

4. 左側の Available Instrumentsリストで PA800PLUS#1をクリックし、右側の New
System Instrumentsリストにドラッグし、Nextをクリックします。

5. 次のようにページのフィールドを更新します。
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図 4-15 Access Controlページ

a. Share System with Other Network Users:選択すると、他のネットワークユー
ザーがシステムにアクセスできるようになります。

b. AllowedAccess:システムへのアクセスを許可するユーザーの種類を選択します。
オプションは Owner Only、Owner and Group(s)、または Owner, Group, and
Worldです。後者の 2つについては、Allow Access to Group(s)リストでグルー
プを選択します。

c. Allow Access to Group(s):システムへのアクセスを許可するグループを選択しま
す。

1つ以上のグループを選択する必要があります。

d. Password Protect System Access:パスワードを要求するには、Password
Requiredを選択します。Passwordおよび Confirm Passwordフィールドに、
パスワードを 30文字以内で入力します。

e. Nextをクリックします。

6. 次のようにページのフィールドを更新します。
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図 4-16 New Chromatography System Wizardの Name Selectionページ

a. SystemName:システムの名前を30文字以内で入力します。この名前は、Empower
データベースおよび Configuration Managerウィンドウで使用されます。

b. Online:新しいシステムをオンラインにするには、このチェックボックスをオンに
します。

c. System Comment:（オプション）システムのコメントまたはその他の識別情報
を 250文字以内で入力します。

d. Finishをクリックします。

e. 別のオンラインシステムで構成されている既存のシステムに関するメッセージが
表示される場合は、OKをクリックします。

バッファーとサンプルトレイの定義

Waters EmpowerTMソフトウェアでは、PA 800 Plusシステムのサンプルトレイとバッファー
トレイは「プレート」といいます。プレートは、Waters EmpowerTMソフトウェアで定義す
る必要があります。このプロセスを簡略化するために、SCIEXは、インポート可能な必要な
情報を含むテキストファイルを提供します。

1. PA 800 Plus EmpowerTM Driver DVDを DVDドライブに挿入します。
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2. Waters EmpowerTM software Startダイアログで、Configure the Systemをクリック
します。

Configuration Manager ウィンドウが開きます。

3. Plate Typesをクリックして、定義済みのプレートを表示します。

図 4-17 Configuration Managerウィンドウのプレートの種類

4. バッファートレイのプレートを作成します。

a. 表内を右クリックして、Import from Textを選択します。

b. Browseをクリックして、PA 800 Plus EmpowerTMDriver DVDのPA800Plus Buffer
Tray.txtファイルに移動します。

注： DVDが利用できない場合は、ファイルのコピーがこのドキュメントに含ま
れています。内容をコピーして、テキストファイルに貼り付けます。プレート定

義ファイルを参照してください。

c. New Plate Type Nameフィールドに PA 800 Plus Buffer Trayと入力し、OKを
クリックします。
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図 4-18 Import Plate Type From Text File ダイアログ

バッファートレイがConfiguration Managerウィンドウのリストに追加されます。

5. ステップ 4を繰り返して、サンプルトレイを作成します。

• 48バイアルサンプルトレイの場合は、PA800Plus Sample Tray.txtファイルを選択
し、プレートにPA 800 Plus Sample Trayという名前を付けます。

• 96ウェルサンプルトレイの場合は、PA800Plus 96 Well Sample Tray.txtファイルを
選択し、プレートにPA 800 Plus 96 Well Sample Trayという名前を付けます。

バッファートレイについては、プレート定義ファイルが利用できない場合、このドキュ

メントでコピーを利用できます。プレート定義ファイルを参照してください。

注： 96ウェルサンプルプレートのプレート定義ファイルは、標準の SCIEX 96ウェ
ルプレート（部品番号 609844）用です。別のメーカーの 96ウェルプレートを使用
する場合は、Configuration Managerウィンドウで File > New > Plate Typeをク
リックして、プレートを手動で定義します。

6. Beckman Coulter PACE MDQ Control for Waters EmpowerTM Software Driverを以前に
インストールしていた場合は、このドライバー用に作成したプレートを削除します。

プレートの行番号を右クリックして、Deleteを選択します。

7. （オプション）プレートに関する詳細情報を表示するには、プレートの行番号を右ク

リックして、Propertiesを選択します。

8. （オプション）プレートを削除するには、プレートの行番号を右クリックして、Delete
を選択します。

削除できるのは、ユーザーが追加したプレートのみです。定義済みのプレートは削除

できません。
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9. File > Exitをクリックして Configuration Managerウィンドウを閉じます。
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• GPIBインターフェースケーブルを LAC/Eモジュールから取り外すと、PA 800 Plusシス
テムへの通信が失われます。GPIBインターフェースケーブルを接続してから、LAC/Eモ
ジュールを再起動します。

• サンプルセットメソッドでは、Injection Volume注入量フィールドの値はすべて無視さ
れます。代わりに、Waters EmpowerTMソフトウェアは注入イベントのDurationパラメー
ターを使用して、注入量を決定します。

• トレイ位置に sample lidを選択すると、Inject Pressure Capillary Fill内にエラーが発生
します。代わりに、トレイ位置にSampleを選択し、バイアルの増分を1に設定します。

注：特定のバイアルに戻す必要がある場合、ユーザーは特定のメソッドをプログラミン

グする必要があります。
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このセクションには、バッファートレイ、サンプルトレイ、およびSCIEX96ウェルサンプル
トレイのプレート定義が含まれています。これらのプレートは、Waters EmpowerTMソフト
ウェアで定義する必要があります。

ファイルは、PA 800 Plus EmpowerTM Driverのインストールの一部としてインストールする
必要があります。

それらが存在せず、プレートを定義する必要がある場合は、テキストをコピーしてテキスト

エディターに貼り付け、ファイルを保存します。
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PA800Plusバッファトレイプレート定義ファイル
Empower Profile for Plate Type: CE Buffer Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 85.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 9.00
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 6
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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PA800Plusサンプルトレイプレート定義ファイル
Empower Profile for Plate Type: CE Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 9.00
  Top Left Well Y Location: 17.10
  Well Diameter: 12.00
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 8
  Row Spacing: 13.40 mm
  Number of Columns: 6
  Column Spacing: 13.40 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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PA800Plus 96ウェルサンプルトレイプレート定義
ファイル
Empower Profile for Plate Type: 96-Well Sample Tray
 Plate Type: XY
 Permanent: No
 Plate Terminology: Plate
 Well Terminology: Well
 Plate Dimensions:
  X: 85.00
  Y: 128.00
  Height: 17.00
 Well Dimensions:
  Top Left Well X Location: 11.00
  Top Left Well Y Location: 14.50
  Well Diameter: 6.80
  Well Depth: 14.00
 Row and Column Dimensions:
  Number of Rows: 12
  Row Spacing: 9.00 mm
  Number of Columns: 8
  Column Spacing: 9.00 mm

 Row and Column Offsets:
  Row Offset Type: None
  Row Offset: 0.00 mm
  ColumnOffset Type: None
  Column Offset: 0.00 mm
 Origin: Bottom Left

 Scheme:
  Referencing: XY
  Horizontal: ABC ...
  Vertical: 123 ...
  Sequential Continuous: Off
  Horizontal First Priority: On
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お客様のトレーニング

• 北米：NA.CustomerTraining@sciex.com

• ヨーロッパ：Europe.CustomerTraining@sciex.com

• ヨーロッパおよび北米以外：sciex.com/education

オンライン学習センター

• SCIEX Now Learning Hub

消耗品を購入する

SCIEX消耗品の再注文はオンライン（store.sciex.com）をご利用ください。ご注文の場合は
見積書、注文確認書、または発送書類に記載されているアカウント番号をお使いください。

現在、SCIEXオンラインストアは米国、英国、ドイツのみに対応しておりますが、将来的に
他の国にも拡大予定です。米国、英国、ドイツ以外のお客様は、地域のSCIEXサービス担当
者までご連絡ください。

SCIEXサポート
SCIEXおよびその代理店は、十分に訓練を受けた保守／技術専門要員を世界中に有していま
す。システムまたは起こり得る技術的問題に関するご質問にお答えします。詳細な情報につ

いては、SCIEXウェブサイト (sciex.com)を参照するか、以下の連絡先までお問い合わせく
ださい。

• sciex.com/contact-us

• sciex.com/request-support

サイバーセキュリティ

SCIEX製品のサイバーセキュリティに関する最新のガイダンスについては、
sciex.com/productsecurityを参照してください。
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ドキュメント

このバージョンのドキュメントは、以前のすべてのバージョンのドキュメントに優先します。

このドキュメントを電子的に閲覧するにはAdobe Acrobat Readerが必要です。最新バージョ
ンをダウンロードするには、https://get.adobe.com/readerにアクセスします。

ソフトウェア製品のドキュメントについては、ソフトウェアに付属のリリースノートまたは

ソフトウェアインストールガイドを参照してください。

ハードウェア製品のドキュメントを検索するには、システムまたはコンポーネントに付属の

カスタマーリファレンス DVDを参照してください。

ドキュメントの最新版はSCIEXのwebサイト（sciex.com/customer-documents）で入手でき
ます。

注：このドキュメントの無料の印刷版を請求するには、sciex.com/contact-usまでお問い合
わせください。
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